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Creating course materials with ADA compliance in 
mind might seem daunting at first, but with practice, 
it becomes second nature. This booklet was created 

to guide you through the process. Word documents, PDFs, 
PowerPoint presentations, videos, interactive presenta-
tions and Blackboard are all discussed. The standards on 
these pages adhere to Web Content Accessibility Guidelines 
2.1 and to Suffolk County Community College’s website 
accessibility policy. 

Web Content Accessibility Guidelines 2.1
https://www.w3.org/WAI/WCAG21/quickref/

Suffolk County Community College’s 
Website Accessibility Policy

https://www.sunysuffolk.edu/accessibility/website-accessibility-policy.jsp

For more help creating accessible documents and media, 
please go to the College websitegExplore Academicsg 
Online EducationgOnline FacultygAccessibility
https://www.sunysuffolk.edu/explore-academics/online-education/faculty/
accessibility.jsp
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Documents
Microsoft Word Documents 

• Use Word’s built-in formatting styles to create headings,
page numbers, columns, tables, footnotes, and bul-
leted/numbered lists. Formatting styles help users using
screen readers to navigate through a text.

• Use Styles to structure content hierarchically by heading,
subheading, and paragraph.

• Use fonts that are at least 12 points in size.
• Make sure there is a 4.5 to 1 contrast ratio between the

background and text colors.
• Try to limit fonts to Times New Roman, Verdana, Arial,

Tahoma, Helvetica and Calibri. Standard fonts such as
these are easy to read and render correctly in both Mac
and Windows platforms.

• Avoid using text boxes.
• Make sure to include a header row when making a table.

Test the table with a screen reader to make sure the
screen reader reads the content in the correct order.

• Do not use color to relay important information. Users
who are color blind or visually impaired might not be
able to see or distinguish between colors.

• Include alt text for all images, graphics, charts or graphs
that are informational. Screen readers read out alt text
for users who are visually impaired.

• Multiple images or graphics that are meant to go
together to form one object should be grouped.

• Meaningful text is used when creating hyperlinks.
Microsoft. (n.d.). Make your Word documents accessible to people with 

disabilities. Retrieved 2018, from https://support.office.com/ 
en-us/article/make-your-word-documents-accessible-to-people- 

 with-disabilities-d9bf3683-87ac-47ea-b91a-78dcacb3c66d?ui=en-U 
 S&rs=en-US&ad=US
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Using Heading Styles in Microsoft Word 
Instead of bolding or underlining text to indicate differ-
ent sections of a document, use heading styles instead. 
Heading styles enable students using screen readers to 
jump to different parts of a document without the screen 
reader having to read through the entire text. 

Using Heading Styles in New Documents

1. Click the File tab, select New > Blank Document.

2.	 Go ahead and type your document, switching between 
a heading style (Home tab > Styles) when you type a 
heading and Normal, when you type body text.

3.	 You can also choose from other types of styles by  
expanding the Styles panel. 

Applying Heading Styles to Existing Documents

1. Open the document to which you would like to add 
heading styles.
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2.  Select all the text by choosing Select > Select All.

3. Select a heading style to apply to your text.

Creating Custom Heading Styles

1.  To modify a heading style, right-click the style in the 
Styles toolbar, then select Modify.

2.  To create your own style, expand the Styles toolbar by 
clicking on the last arrow in the scroll bar, and select 
Create a Style.

Microsoft. (n.d.). Customize or create new styles in Word. Retrieved 2018,   
 from https://support.office.com/en-us/article/customize-or-create-  
 new-styles-in-word-d38d6e47-f6fc-48eb-a607-1eb120dec563
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Using the Microsoft Office 
Accessibility Checker 

The Accessibility Checker in Word, Excel, and PowerPoint 
can help identify possible accessibility issues in a docu-
ment. The instructions below apply to Office 2010 and 
above.

1. Open a document in Microsoft Word and go to File > Info.

2. If the Accessibility Checker sees any potential issues, you  
will see a message next to the Check for Issues button.

3. To view and repair the issues in your file, click Check for 
Issues > Check Accessibility.
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4. Your file will reappear and the Accessibility Checker 
task pane will show the inspection results.

5. Click a specific issue to see additional information and 
steps you can take to edit the content.

Accessibility Checker Inspection Results

• Each issue is classified as an error, warning, or tip.

• An error is for content that makes a file very difficult or 
impossible for people with disabilities to understand.

• A warning is for content that in most, but not all,  
cases makes a file difficult for people with disabilities to  
understand.

• A tip is for content that people with disabilities can  
understand, but that might be better organized or  
presented in a way that would improve their experience.

Fixing some issues might require you to change, reformat, 
or update your content. Accessibility Checker also lets 
you know about Office features you can use to make your  
content more accessible.

Microsoft. (n.d.). Use the Accessibility Checker to find accessibility issues.   
 Retrieved December 12, 2018, from https://support.office.   
 com/en-us/article/use-the-accessibility-checker-to-    
 find-accessibility-issues-a16f6de0-2f39-4a2b-8bd8-5ad801426c7f
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Creating  Accessible PDFs from  
Word Documents 

When creating PDFs from Word documents, first make 
sure that you have followed the guidelines for Word docu-
ment accessibility. Next, you will need to save the Word 
document as a tagged PDF. These directions will explain 
how this is done. 

1. Click the File tab and then click Save As.

2. Under Choose a Location, choose where you want the 
file to be saved.
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3. In the Save As dialog box, click the arrow in the Save as          
type list and then choose PDF. Next, select Options.

4. Make sure that the Document structure tags for  
accessibility check box is selected, then click OK.

5. Click Save.

Microsoft. (n.d.). Create accessible PDFs. Retrieved 2018, from https://  
 support.office.com/en-us/article/Create-accessible-PDFs-064625E0-  
 56EA-4E16-AD71-3AA33BB4B7ED
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PDFs
Acrobat Pro has tools to check for and correct accessibility 
issues in PDF documents. 

1. Open the PDF document in Acrobat Pro, then click on 
Tools.   

2. Scroll down and then click on Accessibility. 

3. Click on Full Check.
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4. In the Accessibility Checker Options dialog box,  
select the options as shown below, or select or deselect 
options per your specific need. When you are done, 
click on Start Checking.

5. As shown on the following page, a list of which acces-
sibility requirements your document has passed and 
failed will be generated. Click on each title to expand 
the content and follow the instructions.
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Adobe. (n.d.). Using the Acrobat Pro accessibility checker. Retrieved 2018,   
 from https://www.adobe.com/accessibility/products/acrobat/using-  
 acrobat-pro-accessibility-checker.html
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PowerPoint Presentations
When creating accessible PowerPoint presentations,  
establishing the correct reading order of elements on the 
slides is of utmost importance. Follow the tips below to 
ensure that your slides are ADA compliant. 

• Use PowerPoint’s preset slide layouts instead of insert-
ing text boxes and media manually. The preset slide 
layouts ensure that the content is arranged in reading 
order.

 Please note: Text boxes may be used; however, they must be  
inserted into the slide in reading order. To make sure the 
reading order is correct, check the order of the text boxes (or 
any other elements) in the Selection panel. Elements can be  
reordered within this panel

• Use a san serif font no smaller than 18 points.

• Make sure there is a 4.5 to 1 contrast ratio between the 
text color and background. 

• Do not use blinking or flashing animations.

• Apply alt text to any essential images or graphics. 

• Hyperlink text should be descriptive of the website the 
hyperlink leads to. 

• Do not set embedded videos to autoplay.

Microsoft. (n.d.). Make your PowerPoint presentations accessible. Retrieved   
 2018, from https://support.office.com/en-us/article/make-your- 
 powerpoint-presentations-accessible-6f7772b2-2f33-4bd2-8ca7-     
               dae3b2b3ef25
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Videos
In order for a video to be ADA compliant, it must contain 
captions or a transcript, and if needed, audio description 
(see page 20). 

General Captioning Standards 

• Each caption frame should hold 1 to 3 lines of text at a 
time, viewable for a duration of 3 to 7 seconds. 

• Each line should not exceed 32 characters. 
• Each caption frame should be replaced by another 

caption. 
• All caption frames should be precisely time-synced to 

the audio. 
• A caption frame should be repositioned if it obscures on 

screen text or other essential visual elements. 
• When multiple speakers are present, each speaker must 

be indicated. 
• Both upper and lowercase letters should be used. 
• The font should be sans-serif, such as Arial or Verdana. 
• Caption color should contrast with the background color 

at a 4.5 to 1 ratio so that the text is easily readable. 
• Non-speech sounds like [MUSIC] or [LAUGHTER] should 

be added in square brackets. 
• Punctuation should be used for maximum clarity in the 

text, not necessarily for textbook style. 
• Captions should preserve and identify slang or accents.

Murphy, S. K. (2018, January). The ADA and online video captioning  
 standards. Retrieved June 6, 2018, from http://www.3playmedia.  
 com/2013/09/27/the-ada- online-video-captioning-standards/
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Searching for Closed Captioned  
Videos on YouTube 

YouTube contains a wealth of educational content, how-
ever, the auto-captioning built into each video may not be 
accurate. To find videos on YouTube that were captioned 
manually by the content creator, use the directions below. 
Please note: Currently, YouTube does not have audio descrip­
tion (see page 20) capability. Keep this in mind when choosing  
videos to use for your courses. 

1. Enter your keywords in the YouTube search text box 
and click on the Search button.

2. On the results page, click on the Filters button and 
then click on Subtitles/CC.

3. A list of ADA compliant videos will be displayed. You 
can tell if a YouTube video is compliant if the video has 
“CC” under the video description. Outside of the search 
listing, videos with CC (with an underline under it) in 
the video player indicate videos with manually inputted 
captions.
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Using YouTube to Create Captions 
YouTube can be used to create captions for existing vid-
eos. Even if you don’t want to host the videos on YouTube, 
you can download the caption files for use in other applica-
tions, such as Camtasia. You will need to create a YouTube 
account, or, if you have a Gmail account, you can use the 
YouTube account associated with it. 

1. Log into your YouTube channel. Click on the round pro-
file avatar at the top right of the page and then click on 
YouTube Studio.

2. Next, click on Transcriptions on the left pane. 
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3. Find your video on the list and click on the down arrow 
next to the number 1. The number 1 refers to the 
captions that YouTube automatically generated. Then, 
click on Published Automatic. 

4. The caption editing window will open. You’ll see the 
captions greyed out on the left side of the page. To 
edit them, click on Edit in the upper right. You’ll then 
see that the captions will become editable. Make your 
edits by writing in the caption fields (1) and adjusting 
the timing according to the waveform underneath the 
video preview (2) window.

5. To save your changes and publish the video with the 
edited captions, click on Save changes. To download 
the caption file, click on Actions, then Download.
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Audio Description
Depending upon a video’s content, users with visual  
impairments might not be able to understand what is  
happening in a video by captions alone. Audio description 
is a voiceover track that describes the action taking place 
in a video when it is purely visual. For example, a video 
of a magician performing a trick might not be compre-
hensible to someone who cannot visualize the trick being  
performed. Audio description would describe what the 
magician is doing step by step.

YouTube does not currently support audio description. 
However, YouDescribe, a project created by Dr. Joshua 
Miele at The Smith-Kettlewell Eye Research Institute,  
enables users to create audio descriptions for their own 
and others’ YouTube videos. YouDescribe is free to use.

For more information about YouDescribe, please see 
https://youdescribe.org/support/tutorial.
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Creating Captions Manually 
or with Camtasia

Creating your own captions can be tricky. Below are some 
tips that might help make the process easier.

When Creating Your Own Videos

• After creating a PowerPoint presentation, use Camtasia 
to record your narration instead of PowerPoint. Use the 
voice training feature to enable Camtasia to create more 
accurate captions from your voice. 

• If you are not narrating your presentation on-the-fly, 
write up a transcript. You can then upload the transcript 
to Camtasia and synch it to the audio.

• The same process should be followed after creating a  
video by recording the screen.

When Creating Captions for Existing Narration

• If you have a transcript, upload the transcript and  synch 
it to the audio.

• If you do not have a transcript, use YouTube to create 
the captions (see page 15) and then import the caption 
file into Camtasia.

• Add captions in Camtasia manually, line by line.
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Math
Creating math content that is accessible presents unique 
challenges. Currently, MathML is the programming lan-
guage that is used to write math equations that are 
accessible. Equations that is written without using MathML 
will not be read correctly by screen readers. MathType is a 
plugin that can be used in Word to write equations and to 
export content as a webpage. On this page are guidelines 
for accessible math and pages 23–25 in this booklet will 
explore MathML in more detail. 

Guidelines for Accessible Math

• Allow all expressions to be enlarged on screen.

• Ensure that users with visual impairments can read 
scientific and mathematical expressions and that users 
with visual impairments and with physical impairments 
can write expressions.

• Use MathML to provide access to scientific and 
mathematical expressions.

• Use LaTeX to provide access to scientific and mathe-
matical expressions.

• Use prerecorded audio to read static scientific and 
mathematical expressions.

• Use concatenated speech strings for simple scientific 
and mathematical expressions.

• Create scientific and mathematical expressions scripts 
using guidelines for spoken mathematics.

National Center for Accessible Media. (2009). Accessible Digital Media   
 Guidelines. Retrieved November 13, 2018, from http://ncam.wgbh.  
 org/invent_build/web_multimedia/accessible-digital-media-   
 guide/guideline-g-math
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Math on the Web
Putting math on the web means many things to many 
people—publishing research articles, posting quizzes and 
reviews for students, web applications for workflows of 
many kinds, online content in accessible format. For more 
than a decade, Design Science has been at the forefront, 
developing tools and technologies for making the web 
more useful for math and science communication.

MathPage: From Word to the Web

MathType includes MathPage™ technology that easily con-
verts Microsoft Word documents to web pages, properly 
handling mathematical symbols and equations, view-
able in any modern Windows, Macintosh, Unix and Linux 
browser.

Working With Websites and Applications

Most websites and applications represent equations in one 
of a few standard formats such as MathML and TeX, but 
there are many subtle variations. MathType has sophisti-
cated input and output translation capabilities that let you 
ignore the technicalities. MathType lets you copy and paste 
between hundreds of popular websites such as Wikipedia. 
You can also use MathType to paste MathML, TeX, or equa-
tion images in learning management systems, blogs and 
wikis. Find out more in the MathType Works With... pages, or 
if you are technically inclined, find out about writing your 
own input and output translators using the MathType SDK.

Web Publishing

Publishing math and science content to the web is tech-
nically challenging because of the difficulty of displaying 
high-quality math notation in a browser-independent 
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way. MathML has enjoyed impressive success as a format 
for representing and exchanging mathematical notation, 
but browser support remains idiosyncratic. In Internet 
Explorer, our MathPlayer add-on has long been the best 
means of displaying math notation. However, to address 
a wider range of browsers, Design Science formed a part-
nership with the American Mathematical Society and the 
Society for Industrial and Applied Mathematics to spon-
sor an exciting initiative called MathJax. MathJax brings 
high-quality MathML rendering to any JavaScript and CSS 
capable browser.

Math-enabled Web Applications

Wikis, blogs, course management systems, and many 
other kinds of web application must be able to handle 
math notation when used in math and science contexts. 
Such applications not only need to display math, but 
to provide users a way to edit math as well. MathFlow 
Components provides developers and system integrators 
with the editing and display functionality needed to create 
math-enabled web applications. To find out more about 
MathFlow Components and the MathFlow SDK, please 
contact us.

Making Math on the Web Accessible

Accessibility for individuals with print disabilities such as 
low vision, dyslexia and blindness has made great strides 
over the last decade. Formats such as the DAISY-NISO 
standard for Digital Talking Books, and regulations such as 
Individuals with Disabilities Education Act have profoundly 
changed the accessibility landscape for math and science. 
In part because of Design Science’s technical leadership, 
these formats and standards directly incorporate support 
for mathematics notation. Our MathPlayer display engine 
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for Internet Explorer interoperates with leading screen 
readers and offers state-of-the-art math accessibility func-
tionality. Our MathDaisy tool works in conjunction with 
leading DAISY book authoring tools to create accessible 
math and science content. To learn more about Design 
Science’s advocacy and technology for math accessibil-
ity, consult our Solutions for the Accessibility Community 
pages.

Learning More About MathML

MathML is the standard way of encoding mathematics 
notation using XML. Since its introduction in 1998, it has 
been incorporated into many other formats, and is now 
supported to some degree by most math-related software 
packages including browsers, editors, computer algebra 
programs, and publishing software. MathML technology 
is deeply incorporated into Design Science products, and 
the staff of Design Science has played a leading role in 
developing this important new technology. Consult About 
MathML for more information and related resources.

Math On the Web Status Report Archives

Beginning in 2001 and continuing for several years, Design 
Science published a semi-annual Math on the web status 
report with a special focus and an objective report on the 
state of Math on the web software. Consult the Math on 
the web: A Status Report archives for a historical view of 
math on the web. For up-to-date on Math on the web news 
and information, join our Math on the web mailing list.

Design Science. (n.d.). Math on the Web. Retrieved November 13, 2018, from   
 http://www.dessci.com/en/reference/webmath/
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Interactive Presentations
Many of the same principles of accessibility apply when 
creating interactive presentations, aka “eCourses.”

• Use a san serif font no smaller than 18 points.

• Make sure there is a 4.5 to 1 contrast ratio between the 
text color and background.

• Make sure tabs open in reading order.

• Do not use blinking or flashing animations.

• Apply alt text to any essential images or graphics. 

• Hyperlink text should be descriptive of the website the 
hyperlink leads to. 

• Make closed captions and transcripts available. 

• Make sure that all commands can be executed with a 
keyboard, without the use of a mouse. Avoid drag-and-
drop, as this feature is not keyboard accessible.

• Do not set any embedded videos to autoplay.
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Blackboard
In addition to your documents and media being ADA com-
pliant, your Blackboard course also needs to be compliant. 
Most of the same general principles apply.

• Include SCCC’s accessibility statement in your course 
outline.

• Use standard fonts that are 12 points in size or larger.

• Make sure there is a 4.5 to 1 contrast ratio between the 
text color and background. This is especially important 
when creating custom buttons for the course menu.

• Do not use color to convey meaning.

• Include alt text for all images and graphics. 

• Using heading styles when writing text in the text editor.

• Always include a header row if using tables to organize 
content. Test out the table with a screen reader to make 
sure that the screen reader reads the content in the  
correct order.

• Consider using learning modules instead of content 
folders. Learning modules reduce the need to scroll. 
Content folders require a user to scroll down the page 
in order to access all the material.

• Make sure that all your documents, videos, and linked 
content is ADA compliant.

• Remove any unused buttons or tools. 
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SensusAccess
SensusAccess is a self-service solution that automates the 
conversion of documents into a range of alternate formats 
including digital Braille, MP3 audio files, DAISY structured 
audio books and e-books. The service can also be used to 
convert otherwise inaccessible documents such as image-
only PDF files, scanned documents, pictures of text and 
Microsoft PowerPoint presentations into more accessible 
formats. (SensusAccess, n.d.)

A link to the SensusAccess tool (web form) can be found on 
the MySCCC homepage. Once you click on the link, follow 
the directions to begin converting your documents. 

Please note that SensusAccess will not make inaccessible 
documents accessible. It is, however, a handy tool for 
making inaccessible documents more accessible. For 
detailed instructions on how to use SensusAccess, please 
see this eLearning course (you must be logged into MySCCC):  
https://www.sensusaccess.com/sensusaccess-e-learning 
For assistance using SensusAccess or if you have any 
questions, please contact support@sensus.dk

SensusAccess. (n.d.). Retrieved August 8, 2019, from https://www. 
 sensusaccess.com/
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ADA Compliance Checklist
The checklist on pages 28–31 will guide you through the 
steps necessary to ensure that your course is accessible to 
your online course participants. 

Microsoft Word Documents

 ☐ Used Word’s built-in formatting styles to create head-
ings, page numbers, columns, tables, footnotes, and 
bulleted/numbered lists. 

 ☐ Used Styles to structure content hierarchically by head-
ing, subheading, and paragraph. 

 ☐ Fonts are at least 12 points in size.  

 ☐ Standard fonts are used. 

 ☐ There is a 4.5 to 1 contrast ratio between the text color 
and background.

 ☐ Text boxes are not used.

 ☐ Tables include header rows and screen readers read the 
content in the correct order.

 ☐ Color is not used to relay important information.

 ☐ Alt text is included for all informational images, graphics, 
charts or graphs.

 ☐ Multiple images or graphics that are meant to go together 
to form one object are grouped.

 ☐ Meaningful text is used when creating URLs.
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PDFs

 ☐ PDFs created in Microsoft Word follow all the standards 
from the Word document checklist and are exported 
from Word as tagged PDFs.

PowerPoint Presentations

 ☐ The preset slide layouts are used.

 ☐ If text boxes are used, they have been placed onto the 
slide in reading order.

 ☐ Sans serif fonts no smaller that 18 points are used.

 ☐ There is a 4.5 to 1 contrast ratio between the text color 
and background.

 ☐ There are no blinking or flashing animations.

 ☐ Alt text is applied to any essential images or graphics. 

 ☐ Hyperlink text includes the full URL.

 ☐ Embedded videos are not set to autoplay.

Videos

 ☐ Captions and a transcript are included.

 ☐ Audio description is included if needed.

 ☐ There is a 4.5 to 1 contrast ratio between the text color
and background.

 ☐ There are no blinking or flashing animations.

 ☐ Alt text is applied to any essential images or graphics. 

 ☐ Hyperlink text includes the full URL.
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Interactive Presentations

 ☐ Used a san serif font no smaller than 18 points.

 ☐ There is a 4.5 to 1 contrast ratio between the text color 
and background.

 ☐ Tabs open in the correct reading order.

 ☐ There are no blinking or flashing animations.

 ☐ Applied alt text to any essential images or graphics. 

 ☐ Hyperlink text is descriptive of the website the hyper-
link leads to. 

 ☐ Closed captions and transcripts are available. 

 ☐ All commands can be executed with a keyboard, with-
out the use of a mouse. 

 ☐ Videos are not set to autoplay.

Math

 ☐ Allow all expressions to be enlarged on screen.

 ☐ Ensure that users with visual impairments can read 
scientific and mathematical expressions and that users 
with visual impairments and with physical impairments 
can write expressions.

 ☐ Use MathML to provide access to scientific and 
mathematical expressions

 ☐ Use LaTeX to provide access to scientific and 
mathematical expressions.

 ☐ Use prerecorded audio to read static scientific and 
mathematical expressions
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 ☐ Use concatenated speech strings for simple scientific 
and mathematical expressions.

 ☐ Create scientific and mathematical expressions scripts 
using guidelines for spoken mathematics.

Blackboard

 ☐ SCCC’s accessibility statement is included in the course 
outline.

 ☐ Standard fonts that are 12 points in size or larger are 
used.

 ☐ There is a 4.5 to 1 contrast ratio between the text color 
and background.

 ☐ Color is not used to convey meaning.

 ☐ Alt text is included for all images and graphics. 

 ☐ Heading styles are used when writing text in the text  
editor.

 ☐ Tables include header rows and screen readers read the 
content in the correct order.

 ☐ Learning modules are used instead of content folders. 

 ☐ All documents, videos, and linked content is ADA com-
pliant.

 ☐ Both Word and PDF versions of documents are provided.

 ☐ Unused buttons or tools are removed. 
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